
  

 
Pulsonix Design System 

V7.0 Update Notes 
 

 
 
 



2   Pulsonix Version 7.0 Update Notes 

Copyright Notice 

Copyright  WestDev Ltd. 2000-2011 
Pulsonix is a Trademark of WestDev Ltd.  All rights reserved. E&OE 

Copyright in the whole and every part of this software and manual belongs to WestDev Ltd. and may 
not be used, sold, transferred, copied or reproduced in whole or in part in any manner or in any media 
to any person, without the prior written consent of WestDev Ltd. If you use this manual you do so at 
your own risk and on the understanding that neither WestDev Ltd. nor associated companies shall be 
liable for any loss or damage of any kind. 

WestDev Ltd. does not warrant that the software package will function properly in every hardware 
software environment. 

Although WestDev Ltd. has tested the software and reviewed the documentation, WestDev Ltd. 
makes no warranty or representation, either express or implied, with respect to this software or 
documentation, their quality, performance, merchantability, or fitness for a particular purpose. This 
software and documentation are licensed 'as is', and you the licensee, by making use thereof, are 
assuming the entire risk as to their quality and performance. 

In no event will WestDev Ltd. be liable for direct, indirect, special, incidental, or consequential 
damage arising out of the use or inability to use the software or documentation, even if advised of the 
possibility of such damages. 

WestDev Ltd. reserves the right to alter, modify, correct and upgrade our software programs and 
publications without notice and without incurring liability. 

Microsoft, Windows, Windows NT and Intellimouse are either registered trademarks or trademarks of 
Microsoft Corporation. 

All other trademarks are acknowledged to their respective owners. 

Pulsonix, a division of WestDev Ltd. 

Printed in the UK  Issue date: 10/08/11 iss 2 

Pulsonix 
20 Miller Court 
Severn Drive 
Tewkesbury 
Tewkesbury Business Park 
Glos, GL20 8DN 
United Kingdom 

Phone  +44 (0)1684 296 551 
Fax  +44 (0)1684 296 515 
Email  info@pulsonix.com 
Web www.pulsonix.com 

 

 

mailto:info@pulsonix.com
www.pulsonix.com


 Contents   3 

Contents 

CHAPTER 1. VERSION 7.0 UPDATE SUPPLEMENT ...................................................................... 5 
Installing the New Version of Pulsonix.................................................................................................. 5 
Licensing ............................................................................................................................................. 5 
Windows 7 Support .............................................................................................................................. 5 
Changes to Folders ............................................................................................................................... 6 
Support for Macros............................................................................................................................... 6 
Active-X Scripting Language Support ..................................................................................................10 
Support for STEP Format.....................................................................................................................13 
New Base Auto Router ........................................................................................................................18 

Using the Auto Router ...................................................................................................................19 
Design Rule Check – Track Layer ........................................................................................................20 
Changes to Technology dialog .............................................................................................................21 

Layer Class – Exception Only ........................................................................................................21 
Layer Class – Draw Component Mounting Holes............................................................................21 
Layer Class – Physical Copper Layers ............................................................................................22 
Layers – Materials .........................................................................................................................22 
Layers – Thickness ........................................................................................................................23 
Layers – New Track Layer Bias Type.............................................................................................24 
Design Rules – Minimum Pad Land ...............................................................................................24 
Net Classes – Edit dialog changes ..................................................................................................25 
Net Classes – Track Size Limits .....................................................................................................26 
Net Styles – Track Styles ...............................................................................................................28 
Spacing Rules – Match Net Class Pair ............................................................................................28 
DFM Rules – Thermal Rules..........................................................................................................29 
DFM Rules – Testpoint Rules ........................................................................................................29 
DFM Rules – Teardrop Rules.........................................................................................................30 
Design Rules – Drill Spacing .........................................................................................................30 
Pad Styles – Restrict Usage of Pad Styles .......................................................................................30 

Advanced Technology Features............................................................................................................31 
Layers Classes...............................................................................................................................31 
Layers ...........................................................................................................................................31 
Layers Now Have a ‘Facing’ Flag ..................................................................................................32 
Layer Spans...................................................................................................................................32 
Composite Layer Spans..................................................................................................................32 
Micro-vias / Laser Drilled Vias ......................................................................................................34 
Micro-via Keep In/Out Areas .........................................................................................................35 
Board Outline and Areas on Layer Spans........................................................................................35 
Component Spans..........................................................................................................................37 

New Items in Colours dialog................................................................................................................38 
Changes to Bond Pad Options..............................................................................................................39 

Select All Bond Pads .....................................................................................................................39 
Move Chip Body ...........................................................................................................................39 
Change Layer of Bond Pads ...........................................................................................................39 

Insert Track - Show Legal Completion Path..........................................................................................40 
Insert Track - Hug Mode Improvements ...............................................................................................41 
Insert Track - Follow Construction Lines..............................................................................................42 
Changes to Interactive High Speed Routing Option...............................................................................43 

Show Track Limits ........................................................................................................................43 



4   Contents 

Serpentine Differential Pair Tracks.................................................................................................46 
Copy & Paste of Differential Pair Routing......................................................................................46 

Draw Hollow Segments .......................................................................................................................46 
Testpoint Components .........................................................................................................................47 
Improvements to Copying Cutouts .......................................................................................................48 
Drawing Dimmed in Uniform Colour ...................................................................................................48 
Number of Drill Symbol Shapes Increased ...........................................................................................49 
Change of Angle Resolution to 1/100,000th Degree...............................................................................49 
Rotation to Polar Grids ........................................................................................................................50 
Full Optimisation After Move ..............................................................................................................52 
Find Library Items ...............................................................................................................................53 
Find – Count Find Items ......................................................................................................................54 
Find – Via Spans .................................................................................................................................54 
Find – Footprint in Schematics.............................................................................................................54 
Report Maker Command Additions......................................................................................................55 

Is This User Report command ........................................................................................................55 
Report Maximum Track Length and Minimum Track Length..........................................................55 
Report Start and End Positions of Oval Slots ..................................................................................56 
Report Drill Shape, Slot Width & Slot Length ................................................................................56 
Is Micro-Via command ..................................................................................................................56 

Spice Netlist Exporter..........................................................................................................................56 
Save Copy As......................................................................................................................................58 
Auto-Rename - Exclude Locked Items .................................................................................................58 
Type Coordinate – Get From Clipboard................................................................................................58 
‘Align’ options available in Define Pad Shape ......................................................................................59 
Variants Improvements ........................................................................................................................59 

Filled Shapes with Dashed Line Styles ...........................................................................................59 
Name base for Variant Reports.......................................................................................................59 

Cadstar 12 support ...............................................................................................................................59 
Library Changes in V7.0......................................................................................................................59 
Mounting Holes Placed on Non-Electrical Layers .................................................................................60 
Cam Plot Changes ...............................................................................................................................60 

Alter Main Plot Area......................................................................................................................60 
Step and Repeat offset of 0.............................................................................................................60 

Import Spacings Rules using CSV Format Files....................................................................................61 
Using the Import CSV feature ........................................................................................................61 
Using the dialog.............................................................................................................................64 
The Import CSV Report .................................................................................................................64 

 
 

 

 

 



 Pulsonix Version 7.0 Update Notes   5 

Chapter 1. Version 7.0 Update Supplement 

Installing the New Version of Pulsonix 
It is recommended that you back-up all libraries, designs, technology files, profile files and report 
files before installing the latest version. Other than for any technical reason, this is good working 
practice, although you should already have a backup of this data! 

To install Pulsonix, insert the CD or double-click on the download executable and wait for a short 
time. The Autorun facility will start the installation procedure. Follow the on-screen commands from 
the install wizard. You can install Pulsonix 7.0 on top of your existing installation or along side if you 
prefer; however, you do not need to uninstall the old version first. 

Licensing 
If you are using a version of Pulsonix earlier than Version 7.0, you will require a new license. This 
will be supplied to you by email under the contract conditions of your current maintenance 
agreement. 

For existing users upgrading from a previous version, it is recommended that you save the new 
license and overwrite the existing one. When requested during installation, simply click the No 
Change In Licensing check box on the licensing page of the installation wizard. The License 
Manager can be used to add new licenses and make changes to network licensing after the 
installation has been completed. 

Windows 7 Support 
As further confirmation, since the release of Pulsonix 6.1 (and for later versions) the release version 
of the Windows 7 operating system in both 32 and 64 bit variants is fully supported. No earlier 
Pulsonix versions can or will be supported. Also, Beta or pre-release versions of Windows 7 cannot 
be supported. 
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Changes to Folders 
The Folders dialog has been changed for Pulsonix V7.0 to additionally allow the management of 
Macros, Scripts and STEP Models. Each of these is discussed below. 

  

Support for Macros 
You can now create and run macros within Pulsonix. This will record your keystrokes and dialog 
selections, then give you the ability to subsequently save and run them again to repeat the actions that 
were performed. Recorded macros can be saved so they may be reloaded and re-used at a later date. 

Creating a new Macro 

From the Tools menu, select Macros and Record Macro> then Start. 

 
A new macro is now being recorded. You must use the End command from the Macros menu to 
finish recording it. If you change your mind and decide you don’t wish to keep the macro you started, 
use Cancel from the Macros menu. 
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Once the macro has been recorded using Start and Stop it becomes the current macro and you can 
then replay it using the Run Macro command. 

If you wish to save this macro, use the Save Macro option from Macros menu. 

For any previously saved macro that you wish to run, use the Load Macro option from the Macros 
menu.  

 
Once loaded, use the Run Macro button to run it (from the Macros toolbar), it won’t automatically 
run after using Load Macro. If you pressed the Run button on a selected Macro, it will load and run 
at this point. 

Macros Folders 

Macro files are located in a defined list of Macros folders managed from the Macros tab within 
Folders. 
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Running in Absolute or Relative mode 

Within a design view, macros can be run in absolute or relative mode. Running in absolute mode 
means it will replay exactly the same as when it was recorded, a copy of whatever was created 
previously would be created at exactly the same position as before. A macro run in relative mode will 
replay relative to cursor position when the macro is run. 

Macros can be switched to run in Absolute or Relative mode by selecting the Relative Replay check 
box on the Options dialog under Macros. 

 
If Relative Replay is enabled and Run Macro is invoked while the mouse cursor is outside the 
design window, such as when selecting the Relative Replay option from the menu or toolbar, you are 
required to set the relative start position for the macro, using the mouse, before it will run. You will 
also see that the cursor has changed and is now a model cursor to indicate that a relative reference 
point is required. 

Normally when a macro is recorded, only the dialog values that are changed are recorded. Enabling 
the Record All Dialog Values option will result in all values being recorded for a dialog. This can 
change the effect of the macro when it is replayed.  

For example, consider recording the addition of a text item where in the Insert Text dialog the only 
item changed is the text string, to 'Example Text', which is then added on the default text layer 
'Silkscreen Top'. If the macro is subsequently run in a design where the default text layer is set to 
'Silkscreen Bottom' the 'Example Text' item will be added on that layer instead.  

However, if the Record All Dialog Values option is enabled before the macro is recorded, although 
the Layer setting in the Insert Text dialog was not specifically changed its value will also be recorded. 
So when the macro is replayed, the text item will be added to the 'Silkscreen Top' layer rather than the 
design's default 'Silkscreen Bottom' layer.  

File Saving During Replay 

If a recorded macro contains a command to save out an item, such as the current design, when it is 
replayed it is possible that the target file may already exist. This option allows you to specify how you 
want a macro to behave in such an event.  

Abort macro will cause a macro to stop immediately without overwriting, Overwrite file will cause 
an existing file to be silently overwritten by a macro and Prompt for alternative file will result in the 
Save As dialog being displayed to allow an alternative file name to be chosen for the save, after 
which the macro will resume replaying as normal.  



 Pulsonix Version 7.0 Update Notes   9 

Macros toolbar 

The Macros toolbar is available to provide quick and easy access to all the Macro commands. If you 
intend recording macros from within a dialog, the Macros toolbar will need to be floating and not 
docked. 

Initially, the toolbar allows you to Start a new macro, Run the current macro in memory, select 
macro Options, Load a macro and Save the current macro. Hovering your cursor over each of the 
toolbar buttons will display its function as normal. 

 
Once macro recording has been started the Stop Macro button and Cancel Macro button are 
available. 

 

Assigning Shortcut Keys to your own Macros 

Shortcut keys, Toolbar buttons and User Tool options can be assigned to macros using the 
Customise option.  

You should first create a User Tool to assign the Macro to. This is done using the Tools tab and after 
assigning a name, select the macro using the Run Macro: option. 

 
Once a User tool has been created using the Keyboard or Commands tab respectively, it can then be 
assigned to a shortcut key placed on a toolbar as a button. 

Limitations of Macros 

There are some small limitations when using macros. For example, you cannot create a macro for the 
Customise dialog or functionality within it. 
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Active-X Scripting Language Support 
Pulsonix 7.0 supports Active-X Scripting languages. You can write scripts for a range of activities 
and functions. These can be run from within the Pulsonix environment or externally from a command 
line. 

Supported Programs 

Pulsonix scripting supports VB Scripts, Python script, JAVA script and Perl script to mention a few 
popular ones. This list includes almost any Active X scripting language that can be used by an Active 
X host. 

Scripts Save Folder 

Scripts can be saved and loaded from the Scripts Folder. This is defined within Folders on the 
Scripts tab. 

 

Running Scripts 

From the Tools menu inside a Pulsonix design, you can use Run Script to get access to existing 
Scripts. This will allow you to select a script from the list and run it. Scripts shown on this list are 
from whatever is defined in Folders under Scripts. 

 
Choose the Run button to run the script. This runs the script and closes the dialog. 
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Test allows you to try running the script without leaving the dialog. 

New will open the Edit Script dialog ready for you to type in your new script. Once created, use the 
Save or Save As button to save it. You can also edit scripts using your favourite text editor or 
development tool, you must ensure you save the script to one of the scripts folders. 

 
Edit will open the existing script in the Edit Script window ready for editing. 

Folders opens the Script page of the Folders dialog. 

Writing Scripts 

To create a new script or edit an existing script, use the Run Script option from the Tools menu. 

 
Use the New or Edit buttons to access the Edit Script dialog. 

 



12   Pulsonix Version 7.0 Update Notes 

Running Scripts from a command Line 

Command line driven scripts can be run outside the Pulsonix environment on a Pulsonix design or 
library. Pulsonix must be installed on the machine running the script in order to be able to do this. To 
run a command line script -  run a command shell from the Taskbar. The command to use will vary 
but generally it will be cmd. This will display a command prompt window. 

 
The scripts used from the command line, or within the program are the same, it is only the method of 
launching them that changes. 

From within the command prompt window, type for example 

Pulsonix /scriptfile  myscript.js  <Enter> 
More information about running command line scripts is available in the Online Help. 

Help for product and command line scripts 

In the Online Help under Index, type Scripting and select the sub-category Overview. This will 
display help pages with an overview of scripting. For a full syntax of scripting available click on the 
Scripting Reference link at the bottom of the page, this will open a separate Scripting reference Help 
system with full programmatical references. 

When running command line driven scripts, there is also Online Help available, please refer to the 
Index entry Scripting and Command Line Scripts. 

Assigning Scripts to shortcut keys or toolbars 

Scripts can be assigned to both shortcut keys and toolbar buttons. To do this, use the Customise 
option from the Tools menu.  

From the User Tool tab select the Run Script: drop down list and select your script name. 
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You will need to assign the user tool a name and then it can be used as a User Tool, a toolbar button 
or as a shortcut. You can only assign shortcut keys to a script defined under User Tools. 

 

Items that can be read by scripts 

Read access is available for many design and library items. Please refer to the online Help to check 
availability. 

Items that can be written by scripts 

There will be some limited write access back into designs and libraries. For example, reading and 
writing Attributes back into library items, where the script searches for all attributes which match 
‘cost’ and ‘0805’ and make these £0.20 

Range of script activity 

There will be limited access to Pulsonix options within the application itself. For example, you could 
run Design Rules Check, check that the number of errors equals 0 and then run CAM Plot to plot the 
design. You can run any command that is ‘in context’, the same as you get from the Edit and Run 
Command option. 

Support for STEP Format 
Where mechanical systems don’t support or have limited support for the DXF or IDF formats, you 
can now export your designs in STEP format. STEP is an ASCII based data exchange format widely 
used by mechanical CAD systems. It can contain 3D component model information, these models are 
often available from a manufacturers web site. 

Exporting STEP format 

There is a new STEP option on Output menu which allows you to produce a STEP model of your 
board. It can also include component models if available. 

 
The Board Thickness is taken from the Layers dialog in the Technology. If the Board Thickness 
hasn’t been setup, you can type your own value in to be used. 

Use the Advanced Settings button to add additional design items to the STEP file. Be aware though, 
selection of these could make your STEP files very large. 
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Folders 

Models are located using the Folders options and STEP Models. Models are not provided but can be 
downloaded from the manufacturers web sites. 

  

Viewing STEP Models in the Library Manager 

STEP Models available to Pulsonix can be viewed in the Library Manager using the STEP Models 
tab. 

 
In the footprint editor you can view the model if the footprint has the <STEP Filename> attribute.  
Once the attribute has been added and a model name provided including the file extension (.stp), you 
can use the View STEP option from the View menu. This will display the STEP model and the 
footprint to enable you to check their alignment and verify the model for that footprint. 
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Using STEP Models 

When outputting the STEP format, it will use existing STEP models if they are available. If not, it 
will use standard Pulsonix Package models defined in the Pulsonix library. 

Models are attached to a Part, Component or footprint definition using an attribute showing the model 
name, see below under The STEP Attributes. 

Within the PCB Editor, there is an option to Generate Heights from the STEP models on the 
Utilities menu. This produces <Component Height> attributes on the Components which have STEP 
models associated. If there are no STEP models associated, then this attribute cannot be extracted 
automatically. The Component Height attribute is required for DRC checking because the STEP 
Model is only a reference to an external model name and not something available directly in the 
design. 

Manufacturers Models and Model File Size 

Some manufacturers have two flavours of models - basic and fancy. The fancy ones are normally a lot 
more detailed but are also a lot larger in size. Generally, STEP files and model files are very large. 

The STEP Attributes 

There are three attributes which can be used on footprints or Parts for STEP models: 

<STEP Filename>  

<STEP Offsets> 

<STEP Rotation> 

 
These attributes can be assigned at any level – in the footprint or Part library definitions, or within the 
design on a component. The attributes are all available as system attributes and are shown in brackets 
and are available on the Attribute Name: drop down list. 

<STEP Filename> The Value will be the model name, you do not require the path as this is taken 
from the STEP Folders list. The Value must include the .stp filename extension. 

 
The name used for the value will usually be defined from the manufacturers own footprint model 
name, but it can be any name you like. 
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Model to Footprint alignment 

The orientation of the component STEP model and the footprint may be different. To make the best 
possible use of existing STEP models, you should create your Pulsonix footprint in the same 
orientation as the model, or vice versa. 

You can add a Model Placement area to the footprint to aid alignment. Pulsonix will use the relative 
height/width of this area to compare with the height/width of the component to decide whether the 
model needs to be rotated or not. You can preview the model to check the footprint alignment with 
the model. Use the View STEP option from the View menu. If the model filename attribute has not 
been defined, a warning message will be displayed. 

For an Area on the footprint, you should check the Model Placement check box on the Area tab of 
the Area Properties. This will be used by the output to best ‘describe’ the position that the model 
should adopt. The STEP model will then be oriented and/or shifted to fit within the Area you have 
defined. 

 
For some STEP models, the model contains an origin with a Z-axis seating plane reference. 

 
When positioning the STEP model in the Z-axis, Pulsonix will by default assume that the model is 
defined with Z=0 on the seating plane of the component. If this is not the case, you can apply an 
adjustment in the Z-direction by adding the <STEP Offsets> attribute to your component. Simply 
supply the distance in mm by which the model should be offset in the Z-direction to bring the seating 
plane in line with the board surface. The adjustment value is added to the current board Z-coordinate, 
so a positive adjustment will increase the Z position and hence move the component upwards away 
from the board surface. You can also make adjustments in the X and Y axes. To make multiple offsets 
in different axes the attribute value takes the form of X=10;Y=5;Z=2. if you do not want an offset in 
an axis just miss it out. The default units are millimetres. If you miss out the axis letter then Z is 
assumed. 

Similarly if you want to apply a rotation in any axis use the <STEP Rotation> attribute. This uses a 
similar notation as the offset attribute. X=90.0 will rotate the model in the X axis. If you miss out the 
axis letter then X is assumed. 
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STEP File Preview 

An option on the Output STEP dialog allows you to Preview the STEP file in it’s own 3D 
Previewer. 

  

 

Previewer Colours and Solid Models 

The colours used in the Preview window can be changed to suit your own requirements. Use the 
Colour Setup dialog from the Setup menu. 

If you wish to view your models as solid shapes, select the Solid Entities option from the STEP 
Preview Colours dialog. 

 

View Model option in Footprint Editor 

While editing your footprint, once a STEP Model filename attribute has been added (using the <STEP 
Filename> attribute and the Model Placement Area has been added, you can preview the model to 
check the footprint alignment with the model. Use the View STEP option from the View menu. If the 
model filename attribute has not been defined, a warning message will be displayed and you get the 
option to preview it using the Pulsonix 3D Package instead. 
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Import Board Outlines from STEP files 

From the File menu you are able to import STEP files using the Import Design Data option. From 
the File of Type: drop down list, select STEP Model.stp  You are able to import Board Outlines in 
STEP format, but currently not Board Cutouts, Areas or Component positions. 

 

New Base Auto Router 
All versions of Pulsonix now contain our new base level autorouter. The ‘high-end’ Advanced 
Autorouter is still available as a cost option where the base router isn’t suitable. The new Auto 
Router is available on the Tools menu. 

 
The name on the menu will be Auto Router, the existing Autorouter (Auto Route>) will be renamed 
on the menu to Advanced Router. 
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Using the Auto Router 

Routing Passes 

 Routing This invokes a number of routing passes which will route either all nets in the design or 
the specified nets, depending on which option started this dialog. You can specify the number of 
passes that you want. The larger your design the more passes you will want to give it. If it routes 
to 100% before the number of specified passes then no more passes will be attempted.  

 Optimising This includes re-routing passes which attempt to reduce the overall track length and 
via count once the Routing passes are complete. You can specify the number of optimisation 
passes that you want. Optimisation can be a slow process, however it can significantly reduce 
the overall track length and via count. For larger boards, this may be an over night process. If 
you already have a fully routed board, you can disable the Routing phase and just use the 
Optimiser.  

 Fanout This invokes a number of passes that route short escape tracks to vias from SMD pads. 
This is done before the Routing passes. Fanout passes are not necessary in order for the router to 
function, and is more useful as a initial phase before manual routing. You can specify the 
number of passes that you want.  

Any of the above pass options can be disabled by unchecking the appropriate box. You can also 
specify Unlimited passes, in which case, the router will continue until the board is complete, or until it 
is cancelled. 

Tracks 

 Use Minimum Width means that if a net has a net class defined the router will use the 
minimum track style as opposed to the nominal track style.  

 Keep Preroutes means that existing routing is protected against being ripped up by the 
Autorouter.  

 Keep Fixed means that only routes that are already fixed will be protected against being ripped 
up by the Autorouter.  

 Fix New means that tracks routed by the Autorouter will become fixed and will remain 
unaffected by the Autorouter if a subsequent routing pass is made, changing the route 
parameters.  

 Routing Style allows you to specify the angle of tracks, either 90 degree (orthogonal), or 45 
degree (angled tracks).  

Check Load Results After Each Pass if you want the display refreshed with the latest results after 
each pass.  

Check Display Report On Completion if you want the Auto Router to produce and display a status 
report when it finishes. 

Costs will display the Costs dialog which you can use to change the cost factors used by the Auto 
Router. You can use this dialog to change the costs involved with ripping up existing tracks and 
inserting vias. You can also restart the Router at a specified Pass.  

Default Costs changes the costs back to their default values.  

The Route option will start the Auto Router using the values specified in this dialog. Close will exit 
this dialog without starting the Auto Router but will store any changed values. 
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Routing By Net Class 

The Routing By Net Class dialog is used to control the nets which are selected for routing.  

Nets which are power or ground, or which have specific properties e.g. high speed or memory etc. 
should be assigned their own net class if they are to be excluded from the routing.  

 
By using the To Route switch, net classes can be selected or deselected for use. 

Route Selected 

For a selected connection or component, you can select the Route Selected command from the 
context menu or from the Tools menu and Auto Router> Route Selected (or Browsed Nets). This 
will route the nets selected using the parameters already defined in the Auto Router dialog. 

Previous Original Autorouter 

Anyone using the original autorouter will no longer be able to use it under Windows 7. If you have 
this situation, please contact our sales office or your local Pulsonix supplier for advice on how to 
resolve this. This does not affect the Advanced Router. 

Design Rule Check – Track Layer 
Within DRC, the Track Layer option will now also add errors for tracks on layers that have their 
routing bias set to No Tracks.  

 
Designs that previously had No Tracks set will be changed to No Autoroute. 
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Changes to Technology dialog 

Layer Class – Exception Only 
You can now create a Layer Class which will only show pads which have an explicit pad style 
exception assigned to that layer. For example, if a layer is required for manufacturing where specific 
vias are to be ‘filled’ or ‘tented’, these can be defined as being on a layer exception. These exceptions 
can then be extracted during plotting by specifying their Pad Condition as Exception Only in the 
Layer Class. 

 

Layer Class – Draw Component Mounting Holes 
You can optionally display Component and Design level Mounting holes separately from within the 
Layer Class dialog in the Technology file. There are two check boxes to differentiate the two 
Mounting hole types. 
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Layer Class – Physical Copper Layers 
Layer Classes have been changed to allow three build status to be available. 

Essential for Manufacturing selected – available for Non-electrical layers. If a Footprint contains 
items on an Essential layer, it cannot be added to a design which does not contain a matching layer. 

Physical Copper Layer check box checked. This check box is only shown if the type is Electrical. 
Most electrical layers must have this box checked as they represent a physical copper layer in the 
construction of the final board. Uncheck it if you need an electrical layer that represents something 
else, for example an inner layer to display embedded component die pads on but not allowing 
copper tracks etc. 

 
This feature and the physical Layer count are discussed further in the Advanced Technology section. 

Layers – Materials 
Within the Technology file and Materials page, the material Thickness can now be added. This will 
be used as the default value when the Layer uses that Material. You can also leave the material 
thickness as zero if you are unsure of its thickness or do not wish to show this. 

 
If you select the Edit button, you can add a Material and its Thickness. 
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Materials and Thickness in Layers dialog 

As stated above, the Materials can be selected during creation of a new layer or can be added to an 
existing layer. 

 
If the Material has a Thickness value defined, this will be used by default. It can also be overridden 
by editing the selected layer and by checking the Thickness box. The new value can then be typed in. 
You cannot directly edit the Thickness value in the Layers dialog unless the Thickness check box has 
been selected. 

 

Layers – Thickness 
Within the Technology file and Layers page, the total Board Thickness is now shown. This will be 
combined thickness of any layer which contains a thickness value, this includes all Electrical and 
Construction layers but also includes Silkscreen layers for example. It will also include unused layers 
where that layer has a thickness defined, Embedding is taken into account. 
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Layers – New Track Layer Bias Type 
When editing a Layer within Technology, a new routing Bias value of No Autoroute has been 
added, this will still allow interactive routing. A routing bias can now be No Tracks or No 
Autoroute. 

 
No Autoroute means no Automatic Routing on this layer. You can use this to disable a layer for 
Automatic Routing.  

No Tracks also means no Automatic Routing on this layer, but in addition any tracks added 
interactively on this layer will be flagged as in error by the Design Rule Check - Track Layer 
option.  

Note Existing designs that used a bias of No Tracks will have that value changed to No Autoroute. 

Design Rules – Minimum Pad Land 
There are now different values for the Minimum Pad Land size for Through Hole Pads, Vias and 
Micro-vias, (Vias and Micro-vias have been added). 

 
The Micro-via Drill Space defines minimum distance between the outer edge of micro-via drill 
holes, regardless of the pad shape. The minimum between micro-via drill holes and other drill holes is 
the maximum of this and the drill to drill spacing above.  
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Net Classes – Edit dialog changes 
The Edit Net Class dialog has been changed for version 7.0 to allow for the new rules. 

Version 6.1 looked like this: 

 
In version 7.0, it looks like this: 

 
Routing now becomes Special Routing (this contains Serpentine Rules etc.). Rules becomes Net 
Rules but is also modified to include the new changes. Size Limits has been added for Version 7.0. 

Each of these dialogs will be discussed below. 
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Net Classes – Track Size Limits 
Size Limit rules for track width and via pad size can now be defined to match by layer name or side 
and within a matched area, and attribute defined sub net. 

 
The Net Class Size Limits define restrictions on the widths of tracks and diameter of vias. They 
would normally be defined for critical nets in the Schematic then passed through to the PCB. This 
gives the Schematic engineer some control over how the net is routed. These rules are applied in 
terms of actual sizes, regardless of the Track and Pad Styles used.  

Track length rules are defined on the Net Rules tab.  

Rule values default to <Unrestricted>, in other words, no rule is applied. You can define a rule 
simply be typing in the appropriate value. Clearing a value will set it back to <Unrestricted>.  

Rules are checked by selecting the appropriate options in the Nets section of the Design Rule 
Checker. None of these rules are currently applied during the design process, and are only checked 
when explicitly selected in the Design Rule Checker.  

How to define a size limit rule 

To create a size limit rule, press the New button. This takes you into a dialog where you define which 
layers, areas and sub-net this rule applies to (for the current Net Class).  

The electrical layer can either be a side (<Any>, Top, Inner, Bottom), or a layer name. The layer 
name can be a wildcard matching string, so 'ground *' would match layers 'ground 1' and 'ground 2'). 

  
Similarly, a wildcard string can be defined to match areas. The matching areas must be marked as a 
Style Override Area. A sub-net is defined by selecting an attribute which all pins in that sub-net 
should have. The value of the attribute is unimportant for this purpose. 
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Size Limits 

Once a new Size Limit rule is defined, it will appear in the list of Size Limit rules.  

 
These rules are applied in the order defined in this list, until the first match is found. You should 
therefore have the more specific rules (in terms of layer, area and sub-net) defined at the top of the 
list. You can move a rule up and down the list by selecting the rule in the list and using the Up and 
Down buttons.  

A rule can be deleted by selecting it in the list and pressing the Delete button.  

Minimum & Maximum Track Width defines the limits of the width of all track used on a net. Any 
number of different track styles can used, but they must all fall between these limits.  

Unchecking the Allow Tracks box means that track will not be allowed at all. So you can effectively 
disallow tracks for this net class on a specific layer, or within certain areas.  

Minimum & Maximum Via Diameter defines the limits of pad styles used on vias on a net. The 
limits apply to the minimum and maximum dimensions of any shape, and includes all shapes 
explicitly applied to any electrical layer.  
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Net Styles – Track Styles 
Track Styles can now be matched by Layer Side or Name. 

 
You can define the default track styles for specific layers or side. If you choose to specify a layer 
name, this can be a wildcard string which may match several actual layer names. Select a Track Side 
if the track styles in this entry are only to be used for tracks that are on a specific side of the board, or 
on all inner layers. This allows you to specify different default track styles to be used on the top or 
bottom of the board for particular net classes. Use Any if the side does not matter. 

Spacing Rules – Match Net Class Pair 
Can now match layer names instead of layer side. Dialog space enlarged to accommodate longer 
match rule names. Matching against a class of ‘*’ also matches items not on a net, and if used, allows 
you to specify spacings for text & board against a specific net class. 
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DFM Rules – Thermal Rules 
You can define Thermal Rules which apply to pads greater than a minimum size. This now lets you 
define Thermal Rules for specific pads by using an attribute that is not tied to a Net Class. This says, 
for a given Minimum Pad Size, the Thermal Rules below it will be applied. This applies when the Net 
Class Override check box is selected. 

 

DFM Rules – Testpoint Rules 
Micro-vias have been added to the list of available pad types for applying Test Points to (or more 
likely, not apply Testpoints to). 
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DFM Rules – Teardrop Rules 
Micro-vias have been added to the list of available pad types for applying Teardrops to. 

 
You can specify what types of pads can receive teardrops. You can choose Through Hole pads 
(including mounting holes), Surface Mount, Vias or Micro-vias. You can also decide if only Round 
pads will receive teardrops, this applies in addition to the pad type restrictions. 

Design Rules – Drill Spacing 
An explicit Micro-via Drill spacing has been added. The greater of the Micro-via Drill spacing and 
the Drill spacing is taken as the Drill to Micro-via rule. 

 

Pad Styles – Restrict Usage of Pad Styles 
You can restrict the usage of a Pad Style by unchecking the For Use By: boxes on the Edit Pad 
Style dialog from within the Technology dialog. So, for example, only pad styles that have the 
Micro-vias check box selected will be shown when you change the style of a Micro-via in the design. 
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Advanced Technology Features 
These features are available in the Advanced Technology cost option. Please note that the previous 
options for Embedded Component and Chip On Board design have been combined and are now 
included in this new (Advanced Technology) option. 

Pulsonix 7.0 now supports Micro-vias, these are laser drilled (usually small) vias between same 
facing layers with the ability to stack them using composite layer spans. Version 7.0 also supports 
Flexi-rigid boards, board cavities and physical embedded components by placing outlines and  cutouts 
on layer spans. 

Layers Classes 
Layer Classes have been changed to allow three build status to be available for Layer Class 
definitions. 

Essential for Manufacturing selected – available for Non-electrical layers. If a Footprint contains 
items on an Essential layer, it cannot be added to a design which does not contain a matching layer. 

Physical Copper Layer check box checked. This check box is only shown if the type is Electrical. 
Most electrical layers must have this box checked as they represent a physical copper layer in the 
construction of the final board. Uncheck it if you need an electrical layer that represents something 
else, for example an inner layer to display embedded component die pads on but not allowing 
copper tracks etc. 

 

Layers 
The Number of Physical Copper Layers reported at the bottom of the Layers dialog now reflects 
the real physical layers in the design. This will depend on the status of the Physical Copper Layer 
check box in the Layer Class dialog, Physical Copper Layers must be selected for it to be counted. 

 
If a layer is marked as Electrical and not Physical Copper Layer then the layer Bias will 
automatically be selected and fixed as No Tracks. Also, the Usually Plotted check box will be 
unselected and greyed out as unavailable for edit. 
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Layers Now Have a ‘Facing’ Flag 
The Mirror Components flag has been replaced with a Facing switch for selection when Can Have 
Associated Layers is selected in the Edit Layers dialog.  

Not only is this used to define the Mirror components status, for a Bottom Electrical layer for 
example, but is also used to define the face for the layer so that it can be used for Micro-via spans.  

For Micro-vias, the face must also be defined if the layer is to be used as a Stop layer in the layer 
span definition. 

 

Layer Spans 
Layer Spans are (still) defined in the Layer Spans dialog from within the Technology. It is from here 
you can define layer spans to use for Vias, Micro-vias, Board Outlines, Areas and Components. 

A layer span becomes a Micro-via type by having the same Facing side on its Top and Bottom 
Layers. To use a micro-via technology you should define the span between same facing layers. 

 

Composite Layer Spans 
Composite Spans are used for connecting multiple layer spans together.  

Using a combination of Micro-via and normal spans, you can define a Composite Layer Span.  

A Composite Layer Span is specifically for creating a via ‘stack’. That is, a stack of vias which 
together complete the span and which move together as one unit, this will usually involve a set of 
micro-vias and sometimes includes a buried via. 

To do this, you must first define each span of the composite. Once created, define the Composite 
Span by selecting the From Layer: and To Layer: layers using the drop down list. If these are legal 
layers which can create a composite span. The Make Composite button will be available. 
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The Add Composite or Edit Composite button will offer you a dialog showing each possible 
combination of spans which will cover this composite overall span (if there is more than one, press 
Next to cycle through each one). Press OK to define the composite. You can change a composite 
back to a normal span by pressing the Clear Composite button from within the Edit dialog. 

Once you have a composite span defined, you must then define the Pad Style to use on each via in 
the stack. Only nets which have composite styles defined using Net Styles can use the composite span 
to create stacked vias. 

Net Styles 

To use a Micro-via layer span or Composite layer span, you will require an entry in the Net Styles 
for a net (Net Styles is enabled from the General page of the Design Settings option). When 
composite spans are used it causes a via stack to be added rather than a single via, each via in the 
stack using the pad style defined in the net styles entry. 

Using Composite Layer Spans 

Composite via stacks can be added using Add Via, or added automatically by changing layers of 
tracks. If using Add Via, then the same restrictions to the function will apply as when using Insert 
Multiple (no finish markers, test point, design clearance etc). 

Selecting a via in a stack selects all vias in the stack, and the status bar tells you so. This is so the 
stack can be moved as one, but the individual vias in the stack can be selected using Select Next. 
Once a via has been moved away from the rest in the stack, the stack is no longer complete and will 
not be selected as one item. 

Composite span stacks will be shown in the Layer Stack Preview, and in the 3D Viewer.  
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Micro-vias / Laser Drilled Vias 
A Via using a Layer Span between two same facing layers, is defined as a Micro-via. 

Entry Pads and Stop Pads 

There are two special Pad Style exceptions (defined in the Technology) for Micro-via Entry Pad 
and Micro-via Stop Pad. These define the pad sizes used on the entry and stop layers when the style 
is used for a Micro-via (unless there is an explicit exception for that layer, which will be used 
instead). These provide a simple method of defining specific Entry and Stop pad sizes, they are not 
mandatory for Micro-vias.  

This pad definition is used for creating ‘tapered’ Micro-vias, where the Entry and Stop pads are 
different diameters to match the ‘taper’ effect caused by the laser drilling. 

 
A Micro-via showing a tapered hole 

It is also possible to create a set of ‘stacked’ Micro-vias using a Composite Layer Span. Without 
Stop pads, the laser will simply ‘cut’ to a depth or until it reaches a Stop pad. Multiple ‘tapered’ via 
spans are also possible using Composite Layer Spans using different Via Pad Styles. 

  
Two examples of Stacked Micro-vias (Composite) 

Creating Entry and Stop Pads 

Edit the Pad Style and use the By Layer option, then for Type: select Micro-via Entry Pad from the 
drop down list. The Layer: box will now be greyed out as un-selectable. Type a value for Width: if it 
needs to be different to the default stack value and then press OK to exit and save the exception. 

 
Normally, you would also do the same for the Stop Pad so the laser knows where to start and where 
to stop drilling, although this isn’t mandatory for some processes. The Stop pad is displayed as a solid 
pad even though the default pad stack is defined with a drill hole, and the Entry pad is displayed with 
a drill hole shown (depending on Layer Class settings). 



 Pulsonix Version 7.0 Update Notes   35 

The Pad Style entry for that pad would then look like this (shown for Micro Via 400): 

 
 

 

Drilling Micro-vias 

Micro-vias are ‘drilled’ (using a laser or plasma ‘drilling’ machine) using the standard Excellon NC 
Drill output. Special customised reports can be generated using the Report Maker option on the 
Outputs menu. All pad styles on any layers and the drill position can be output if required, see new 
Report Maker commands for details. 

Micro-via Keep In/Out Areas 
Areas can now be set to Keep In/Out for Micro-vias, this is a completely separate option from an 
area being set to Via Keep In/Out. 

 

Board Outline and Areas on Layer Spans 
You can now add a Board Outline, Board Cutout or Area to a layer span. You can also add a 
combination of board outlines or areas on different layer spans to represent how they will be used for 
those layers, a flexi-board outline on an inner layer span for example. 

To add board outlines, cutouts or areas to a span, you must create a suitable layer span in the Layer 
Span dialog. This has previously been exclusively used for via spans, but is now used for shapes and 
components as well. Component Spans are discussed below. 
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Board Spans 

A Board on a layer span redefines the outline for that span. For example, it is possible to define a 
flexi-board on an inner layer span, which overhangs the outer board outline. It is possible to add 
normal components to the overhangs. For normal boards, the board outline would remain on 
<Through-board> Layers. 

In the Layers dialog, create the Layers and Layer Classes, in our picture above for two ‘inner’ 
layers, Flexi Top and Flexi Bottom.  

  
You also need to edit the layer to Allow Normal Components. 

 
The Layer Spans are defined once the Layers and Layer Classes have been created, in our example 
below the span is across <Flexi Top> and <Flexi Bottom>.  

 
When selecting a Board outline, Area or Board Outline Cutout, use Change Layer to change to a 
Layer Span selected from the drop down list, a list created from the legal Layers Spans available. 

Board Area Cutouts 

You can also define holes and cavities using a Board Cutout Area, and components can be placed 
within these cavities (if you have the Advanced Technology option). Board Area Cutouts are 
defined as holes or cavities through the use of Layer Spans from the Technology dialog, the same as 
Board outlines and Areas. Where a ‘cavity’ is to be created in a board, this is simply a Board Area 
Cutout spanning the required layer span. 
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Component Spans 

Placing Components on Flexi Boards and within Cavities 

Surface mounted components can be placed onto flex board and in cavities by changing their layer to 
the inner layer they will sit on. The layer must have Allow Normal Components enabled to be able 
to do this. Through-holes components can also be placed on the surface of an inner layer span of a 
flexi part of the board, or in a cavity within the board. You must create a Layer Span to cover the 
span required to be able to move the component onto. 

Define the span that the component’s pads will need to reach the other side of the board from the 
layer the component is being placed on. The component’s Through-hole pads, mounting holes, 
component vias and areas will be changed to use the chosen layer span. 

The Layer Span selected must have been first defined in the Layer Span dialog of the Technology. 
Choose the span which the component will fit across. For example, a component might span Layer 3 
to Layer 4 but sits inside the cavity that spans these layers; a cutout in the Prepreg or other 
construction layer. 

  
When creating components, cavities or holes in the board outline can be defined up-front as part of 
the footprint. These are created as Areas and with the Board Cutout check box selected. Obviously, 
the Area needs to be defined to span the appropriate layers within the design. 

Moving Components to a layer span 

To move a component onto the new Layer Span required, select the component and from the context 
menu, select Change Layer. Select your span choice from the drop down list. Only layer spans that 
start or end on layers that can have components will be available. A Mirror Component check box 
will be available to say which side of the span the component will be placed on. 

The Design Rules Check (DRC) option will check that pads, mounting holes etc. will fit the span 
defined. 

Also, Mounting Holes in a PCB design can now be assigned to a Layer Span. This allows you to 
place construction holes into the flexi board without having to use a via. 
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Components which are to be used on any other layer span other than conventional <Through Hole> 
do not need any special set up requirements but you should be aware of any supporting layers which 
may or may not be subsequently required, for example Silkscreen layers. 

New Items in Colours dialog 
Due to the Board and Areas on Layer Span changes, the Colours dialog has been changed as 
follows: 

There is now a new Boards & Areas tab. 

 
Areas has been moved from the Elec Shapes tab and Board has been moved from the Others tab. 
Both now appear on the new Boards & Areas tab that contains Layer Spans. 

The Tracks tab has been removed completely. 

Tracks and Breakouts have been moved to the Elec Shapes tab. 

 
The Pads page has also been modified to display Layer Spans. 
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Changes to Bond Pad Options 
There are two new options available on the context menu when part of a single component that 
contains bond pads is selected in a PCB design.  

Select All Bond Pads 
Use the Select All Bond Pads option to select all of the bond pads on the component. Once all the 
bond pads have been selected, this could be used for changing their layer or style for example. This 
option is part of the Advanced Technology cost option. 

 

Move Chip Body 
Use the Move Chip Body option to move the chip body without moving any of the bond pads. This 
option is part of the Advanced Technology cost option. 

 

Change Layer of Bond Pads 
Using Change Layer, you can now set the layer of an individual bond pad in a PCB design to any 
reference layer that is facing the same way as the layer the component is on. This is to support the 
placing of the body of bare die components into cavities and to have their bond pads still on the top 
side. 

You can also change the layer of multiple bond pads on one component using the Properties dialog. 
Both operations are part of the Advanced Technology cost option. 
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Insert Track - Show Legal Completion Path 
There is a new Insert Track option (Show Legal Completion Path) to display the natural 
completion path to the target item if it is legal to complete in two or less segments to the target 
without introducing any spacing errors. It will display the potential segments as hollow tracks of the 
correct width and in the Unfinished Track colour. This option is also available from the context 
menu when editing the track. 

 
If Complete As Track is used, either from the context menu or by using double-click, and the 
completion path is shown it will be used to complete the path quickly, without the need to check the 
track or push any more tracks away. 
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Insert Track - Hug Mode Improvements 
When hugging with Online DRC switched on, any obstacle you hit will be added to the hug path so 
you can hug around them, this includes Copper, Pads, Mounting Holes and Vias. This allows 
hugging to ‘jump’ to the next obstacle in its way. 

Hug Mode Options 

There are now three hug methods on the Edit Track page of the Options dialog. 

 
Shielding adds tracks that hug the obstacles as tight as possible, introducing arcs around pads and 
sharp corners (see below). This can be used to create shielding around tracks and other copper 
obstacles for RF protection for example. 

 
Routing is like shielding, but will add 45 degree lines around pads and sharp corners. It will only use 
Arcs to hug around arcs in copper shapes. 

 
Gridded will add a track with all segments a multiple of 45 degrees and snapped to the next track 
grid position away from the obstacle. 

 
Check the Always Uses Minimum Gap option to force track hugging to always hug to the minimum 
gap allowed by the Spacing Rules in your Technology. Leave unchecked to allow track hugging to 
hug at the initial distance from the track to the shape, or to type a required gap. 
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Add Track 

When in Add Track, and before clicking to start the track you can now select Start Hugging from 
the context menu. If you are directly over a shape on the current layer it will start hugging it, 
otherwise it will enter a special mode to pick the item to hug around.  

Type Gap 

When in the special mode to pick the obstacle to hug, you can now type the required gap. 

 

Insert Track - Follow Construction Lines 
When editing a track (an existing track or new track) or breakout, you can now choose to use Follow 
Construction Lines from the context menu. The track or breakout will snap to the nearest 
construction line (if it can) and you will enter the Follow Construction Lines mode. A special cursor 
will be shown and wherever you move the cursor the track will follow along the construction line or 
circle and can corner when you reach an intersection with another construction line. You use a left 
click to exit this special mode and return to normal track editing. 

 
When in Insert Track, and before clicking to start the track, you can now select Follow 
Construction Lines from the context menu. A new track will be started on the nearest construction 
line. 
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Changes to Interactive High Speed Routing Option 

Show Track Limits 
In Pulsonix V7.0, there are improvements to the interactive display of Pin to Pin and Net Length 
Limits.  

Previously in version 6.1, the display of Interactive High Speed rules worked so that if a Pin to Pin 
Length rule was defined, it showed that Length and the rule in the ‘head-up’ display. If there was no 
Pin to Pin rule, and if it had a Net Length rule, the Net Length and rule was displayed. If it had no 
rules defined, it would show nothing. 

Now in Version 7.0, you have much more control over the Lengths to be displayed. Lengths can now 
be displayed without rules being defined and you can display Pin to Pin Lengths and Net Track 
Lengths at the same time by unchecking the pin rules options in the Options dialog and Edit Track. 

  

Display the estimated Pin to Pin length, Net length and Diff Pair Length Differences 

There are new check boxes on the Edit Track page of the Options dialog that can be unchecked to 
allow you to display the estimated Pin to Pin length, Net length and Diff Pair Length Difference if 
there are no limit rules defined. 

 
All the rules check boxes above in the red panel have been added. 

Additional Net rule display controls 

You can now uncheck the new Only if Pin to Pin Rule Not Defined check box in Edit Track on the 
Options dialog to display both Pin to Pin Length and Net limits. (before it always showed only one 
of them). The Net Limits are preceded by the label Net or Sub-Net depending on where the rule is 
defined. 
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Length difference and Max Limit on a Differential Pair 

When editing a differential pair, you can now optionally show the Length Difference and Max 
Limit. 

 

Resolving unrouted connections to obtain the Pin to Pin length 

The algorithm for obtaining the Pin to Pin Length for paths including unrouted connections and ‘T’ 
junctions has been significantly improved to be more accurate. 

Show Pin Names when showing Pin-to-Pin Lengths 

If showing a Pin to Pin length, the names of the pins are shown (unless the limit is defined by a pin 
network, in which case the Pin Network label is displayed). 

 

Match Pin To Pin Length 

There is a new Interactive High Speed function on the context menu (Match Pin To Pin Length) 
when editing a PCB Track. This allows you to change the head-up track limit display to show the Pin 
to Pin length from another track that you are trying to match the length to. 

While editing a track, if you right click and select Match Pin To Pin Length, if you are over another 
track the option will be used, otherwise a mode will be entered with a special modal cursor to enable 
you to select the track to match lengths to.  
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At this point, you can also type in the required length, rather than selecting another track. 

  
Selecting the option again off the context menu will toggle track matching mode off. Only tracks that 
are fully routed in a single path from Pin to Pin can be selected. 

 
When matching lengths the head-up display will change to show the names of the pins we are trying 
to match, the length of the tracks between them, and the difference in lengths. The difference will be 
shown in the illegal colour if not zero. 

 
If the matched path has vias, or the current path being edited has or needs vias, the display will 
include the estimated and required via counts. 
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Serpentine Differential Pair Tracks 
From within the Interactive High Speed option, you can now serpentine a differential pair. This 
works the same as when you serpentine regular tracks with the Serpentine Tracks option being 
available on selected Differential Pair tracks from the context menu. 

 

Copy & Paste of Differential Pair Routing 
There is no user interface changes, but the Copy and Paste options now copy differential pairs. If all 
four pads are being copied the differential pair will also be copied. In PCB, paired tracks are also 
retained when copying the whole differential pairs. In Schematic designs this allows you to Cut and 
Paste partial designs to another page and not lose the differential pairs. 

Draw Hollow Segments 
There are new display options to draw copper, track and other shape segments that are not ‘True 
Width’ as Hollow outlines instead of centrelines. 

When copper, track and other shape segments have their True Width switched off in the Colours 
dialog, you can now optionally enable the drawing of those shape as hollow width instead of 
centreline. 
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Once the True Width is set off in Colours, from within the Options dialog and Display, you can 
select one of the three check boxes to set copper, track and other shape segments to hollow. 

 
The design will now draw the shapes as hollow as shown below for track segments. 

 

Testpoint Components 
You can now use Change Testpoint or the Test Properties tab on a component that is a single pin 
component to turn it into a testpoint component. Use the new Make component a testpoint part 
check box. A testpoint component is one where the testpoint name and component name are 
automatically kept the same.  

 
For a selected component, the status bar and tooltips now show if a component is a testpoint 
component. 
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Improvements to Copying Cutouts 

Copying Cutouts 

There is new option on the Options dialog under Interaction called Copy Single Cutout As Shape. 
This allows Copy to take a single selected cutout and turn it into a single shape on the clipboard. This 
can then be used by the Paste command within the Insert Cutout or Insert Merge operations to add 
it back in as another cutout. 

Insert Cutout and Insert Merge changes 

Insert Cutout and Insert Merge have been changed to stay in their mode after using Paste. This 
makes it easier to paste the same Cutout shape multiple times.  

Insert Cutout can now convert multiple shapes to become Cutouts of a selected shape.  

This is done by first selecting the multiple shapes you want to become Cutouts, then place them over 
the master shape. Next, with the shape still selected, use Insert Cutout to pick the master shape to 
receive the cutouts.  

A warning dialog will be displayed, asking if you want to convert all the preselected shapes to 
cutouts.  

 
If you click Yes, the shapes will be cut out of the master shape. If you click No, the shapes are 
ignored. 

Drawing Dimmed in Uniform Colour 
The ability to dim (lowlight) while editing using a uniform colour for all items has been added. A 
black background will show all dimmed items as dark grey and a white background shows very light 
grey, etc. This is controlled by a new check box on Tools dialog and Options, Display. Select All 
Dim in One Colour to enable this feature. 
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Number of Drill Symbol Shapes Increased 
More drill symbols have been added. Including 3 to 6 point stars, 3 to 5 leg symbol, 3 leg asterisk. 
The filled property of a shape which is drawn with lines (such as asterisk, target, etc) determines if the 
shape is drawn with a predefined width, or minimum width (the same as unfilled closed shapes). 

 
These would be displayed in the design on the drill table and in the drill drawing like this: 

 

Change of Angle Resolution to 1/100,000th Degree 
The internal resolution of angles is now 1/100,000th of a degree. There is no interface change for this. 

This has been changed to allow a more accurate calculation of the ‘crossing’ position when lines 
intersect with arcs for example.  

For existing users who had an accuracy problem snapping items to intersections, between circles and 
straight construction lines, you might have to reposition the lines to more accurately define the 
intersection points. 
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Rotation to Polar Grids 
There are new rotation functions available: 

Type Rotate 

This new mode is available from the Select Mode and Move context menus.  

 
Use this to rotate the current selection about a particular point and by a specified amount by typing 
the values into a dialog. 

 
If used in Move, the rotation is applied to the selection in its original position unless you are adding 
the first item. This way you can position subsequent items rotated relative to the first item added. 
Also if you are using Duplicate or Apply Layout Pattern, you do not have to use Cancel Move 
before rotating into position.  

The dialog can also be used in Polar form by supplying the Angle and Magnitude of where you want 
the origin of the selection to be. 
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Polar Rotate 

Check this box to change the two edit boxes to accept an Angle and Magnitude to define the position 
of the selected items using absolute polar coordinates applied about the rotation point. The selected 
items will be rotated about the rotation point until their origin is at the required angle and then moved 
towards or away from the origin until the distance from the selection origin to the rotation point is 
equal to the required magnitude.  

Rotate About 

This new mode is available from the Select Mode context menu. For a selected component(s), you 
can choose to Rotate About from the menu and then set the rotation origin. 

 
This option allows you to enter the Rotate One Step latch mode operation and lets you pick the point 
that you want to rotate the selection about.  

  
Once this is selected, the ‘rotate about’ origin is fixed and you click the mouse to make one rotation 
step. 

 
By right clicking in this mode at any time, the Change Rotation Step can also be changed: 
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From the dialog, type the rotation step required: 

 
When the point has been picked, left click anywhere to perform the rotation about that point. 

Change Rotation Step 

This option is available from Select Mode, Move, Rotate Latch Mode and Add Construction Line. 
Use it to change the rotation step in the interactive options. 

Full Optimisation After Move 
From the Options dialog and Move, there is a new move option (Full Optimisation On Drop) to 
perform a full optimisation of all nets involved on finishing the move. This works for Optimisation 
in Continuous and On Drop mode. 

  
This option is also available from context menu when moving components. 
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Find Library Items 
You can now Find in the Parts Library Manager and on the Insert Component option using fields 
such as component Description, Part Family and Footprint.  
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Find – Count Find Items 
There is a new option on the Find browser - Count Found Items. This is available on the context 
menu to count all items that satisfy the search criteria. (item type, name filter and attribute condition). 

 
The count results are shown in the Find bar title. Categories of named items always show the count 
whenever their list is refreshed. 

 

Find – Via Spans 
When using Find Via, it now allows you to find composite via layer stacks. The layer filter now 
includes composite spans, and if one is chosen, all vias in the composite stack are found and selected 
together. 

Find – Footprint in Schematics 
The Find Footprint option is now available for Schematic designs. It finds gates on components that 
have a explicit footprint name defined, i.e. not using the default footprint from the part. 

 



 Pulsonix Version 7.0 Update Notes   55 

Report Maker Command Additions 
New commands have been added to Pulsonix V7.0: 

Is This User Report command 
Is This User Report is used within List Of Doc Symbols to return true if the current documentation 
symbol is the inserted user report that is currently having its report text updated. This way you can 
add attributes to the inserted user report containing parameters that influence the contents of the 
report.  

 
When run, the report will test the doc symbol and plug the requested value back into the report. For 
example, like this - where the report created is copied twice in the design, both instances containing 
the attribute NAME but both using two different values (Att Val 1 and Att Val 2): 

  
For example, you could insert a report that lists the ungated power and ground pins on a component 
by adding the component name as an attribute on the inserted report. 

Report Maximum Track Length and Minimum Track Length 
From within a PCB report, the Maximum Track Length and Minimum Track Length can be used 
within List Of Nets to report the min and max track length values from the Net Class rules for the 
current net. These values can then be used to test against the Track Length field to report failures. 

 
When run, the report could look something like this (using added Pre text to the commands): 

Units: mm 
HSE1   10.000    Min: 8.000     Max: 24.000 
HSE2   29.770    Min: 8.000     Max: 24.000 
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Report Start and End Positions of Oval Slots 
The Report Maker can now report the Start and End Positions of oval drill slots. Used in the List 
Of Drills command, it reports the start or end position of the thick line that would be used to draw the 
slot. 

 

Report Drill Shape, Slot Width & Slot Length 
New commands for Drill Shape, Slot Width and Slot Length have been added, These are additional 
sub-fields of the Pad Style command to report information if the pad style represents a slot. 

 

Is Micro-Via command 
To support Micro-vias, a new command, Is Micro-Via has been added. This is available when using 
the command for List of Vias. 

 

Spice Netlist Exporter 
From within Schematics, export to other types of Spice, such as LTSpice, Basic Spice and PSpice. 
Pulsonix Spice format can also be output, this is also compatible with the SiMetrix and Simplis Spice 
simulators. 

Most of the integrated simulation features available in Pulsonix are specifically designed for use with 
the Pulsonix-Spice simulator. For example, Random Probing, Bias Annotation and Multi-Step 
Analysis. If you do not have this simulator, you can still prepare components for Spice output and add 
circuit stimuli and fixed probes, and generate a Spice netlist. 
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To set the Spice Netlist Type 

Before running a Spice netlist, you must choose the type to export to, each one has its own ‘flavour’ 
of Spice. Select the Set Netlist Spice Type from the Simulation menu in Schematics. 

 
First choose the Spice Netlist Type from drop down list for the simulation file. The simulator 
commands in the netlist file will be formatted to suit the chosen simulator.  

 
If available, you can choose to use the Run Simulator check box to specify whether you can directly 
run a simulator as well as producing the Spice netlist. 

Use the Browse button to locate the program to be run on your computer. Where possible we have 
added filters to this dialog to suggest a possible simulator program name. 

Add any command line switches that are needed to run up the simulator, either before or after the 
output filename. Initially these will be set to default values for each simulator type. If you change 
them you can use the Reset button to revert back to the default values. 

Press OK to accept the change. If Run Simulator is checked you will be able to use the Simulate 
Design option to pass your Spice netlist directly to your simulator. 

Outputting a Spice Netlist 

To generate a Spice netlist in the format you have chosen, If the Program has been previously set up, 
use the Run Simulation option from the Simulator menu. If this has not been set up, you have to use 
the Create Spice Netlist File> (the Simulator menu), then choose one of the page options and the 
location using the Save As dialog.  
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Save Copy As 
You can save a copy of the current design under a new name, whilst continuing to edit the current 
design. 

From the File menu, select Save Copy As. From the Save As dialog, choose the location and 
filename to save the file to. 

 

Auto-Rename - Exclude Locked Items 
While using Auto Rename, you can now exclude locked items from being renamed by unchecking 
the Include Locked Items check box (you cannot lock a net). 

 

Type Coordinate – Get From Clipboard 
When using Type Coordinate to position an item, there is a new button available - Get From 
Clipboard. This is enabled if the clipboard contains a text item that includes a valid coordinate. The 
text in the clipboard may have been copied from a report for example. 

If pressed, the coordinate X and Y values will be placed into the appropriate edit boxes. 
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‘Align’ options available in Define Pad Shape 
The Align options are now available whilst in Define Pad Shape. They are available on the Edit 
menu and available as commands. The Alignment toolbar is also available for use by selecting it in 
the Customise dialog and Toolbars. 

Variants Improvements 

Filled Shapes with Dashed Line Styles 
When a shape uses a Dashed line style and is also Filled, the shape is not drawn filled but is still 
selectable as a solid shape. Previously, this was not possible, the shape was drawn as solid. This is 
useful for Variant Components for example. 

 

Name base for Variant Reports 
From within the Report option on the Output menu, you can now base your report name on Variant 
or Variant + Report Title or Design Name + Variant + Report Title using the selections on the 
drop down list. 

 

Cadstar 12 support 
Pulsonix 7.0 can now import Cadstar 12 format ASCII files in .csa and .cpa formats. 

Library Changes in V7.0 
In Pulsonix 7.0, new Parts libraries have been added and some existing libraries modified, over 
20,000 new parts have been added, the additions comprise the following: 

Manufacturer Items added 
Altera 1110 
LT 1606 
Maxim 15884 
Microchip 22 
NatSemi 572 
Xilinx 3264 
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Mounting Holes Placed on Non-Electrical Layers 
Mounting holes that are not on a net can now be placed on non-electrical layers. This supports the use 
of mounting holes in footprints as glue spots, and allows you to change individual instances in a PCB 
design to have an alternative style for the Mounting Hole to cope with particular manufacturing issues 
on a per component basis. 

Cam Plot Changes 

Alter Main Plot Area 
There is a new switch on the Plot Wizard Offset page named Alter Main Plot Area. This is used 
when you are adding additional plots to a main plot to create a composite. You specify if the offset 
plot area will be added to the main plot area. If checked, and the main plot is using Auto Fit or Auto 
Shift, then the main plot positioning will change to include the appropriate area in this additional plot. 
If left unchecked the original positioning of the main plot will not be affected by the offsetting of the 
additional plot. 

 

Step and Repeat offset of 0 
A step and repeat offset of 0 is now allowed. This enables you to plot the separation between boards 
so they can be cut (once manufactured) with a single cut. It will align the centreline of the board 
outlines. Effectively, the board outlines ‘butt’ up against each other. 
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Import Spacings Rules using CSV Format Files 
The ability to import Net Class names and Class to Class Spacing Rules into the Schematic or PCB 
design Technology using a CSV file has been added to Pulsonix. 

Using the Import CSV feature 
The Import CSV button appears on the Spacing Rules dialog along with Match Net Class Pair rule 
level pre-selected. 

 
When selected, the Open CSV file dialog is displayed. You will be prompted to select the CSV file to 
import. The File of Type drop-down list is set to *.CSV.  

Note: If you have been editing your spacing rules in Microsoft Excel for example, you will need to 
save the rules into a CSV file format. To do this, when using the Save As option select CSV (Comma 
Delimited) (*.CSV) format from the File of Type drop-down list. 
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Select the file required from the dialog and press Open. 

 
The Import Class To Class Spacings CSV Data dialog is displayed. This dialog allows different 
styles of CSV files to be imported. Currently, this accommodates a number of format ‘styles’ that 
have been seen within our development department. 

 
Add new net classes – If new net classes need to be added because they exist in the import file but 
not in the design, checking this option will allow this. With this not selected, new net classes are not 
added and any class to class spacings using them will also not be added. 

Keep existing class to class spacings – If the design already has class to class spacings, you can 
choose whether to remove them all and add just the spacings from this import file, or to keep the 
existing ones. Uncheck this option to remove them all.  
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If keeping existing spacings the following check box becomes enabled for you to use to decide what 
to do if the import file contains class to class spacings that already exist in the design.  

Update to new spacing values – If during the import, the option detects an existing class to class 
spacing but the value is different, then you can choose to keep the existing value or update it with the 
new value. Unchecking this box will mean only new class to class spacings will be imported. 

Class to class spacing table 

You can tell Pulsonix how to treat the imported data. It is assumed that the spacings table is a grid 
with net class names in the top row and down the left most column. This spacings table can appear 
anywhere in the CSV spreadsheet and so the user will have to supply its position. The first option tells 
the importer which rows and columns contain the net class names. For this, you define the Row name 
and Column name. 

Net Class names Row Column – enter values like 1 for Row and A for Column names. If for 
example, you had a title at the top of the page on row 1, the net class name may then appear on Row 
2, you would then enter Row 2 instead. You can use either numbers, where 1 is the first, or letters, 
where A is the first and AA and AB are 27th and 28th etc. 

Contains default spacings for each net class Row Column – Some spacing tables contain a special 
row below the net class names row, or a column to the right of the net class names column, or both, 
containing default spacing values for each net class. These values do not form part of the class to 
class spacing values grid, and so the importer needs to know about them so it can skip them, or read 
the default values from them, to reach the main spacing values grid. Check the row and/or column 
boxes if you have these values in your table. 

If either box is checked the following check box becomes enabled to use to decide what to do with 
these default net class spacing values. 

Add defaults as net class spacings – Check the box if you want to add these default values for each 
net class they are defined for to the design spacing rules at the Net Class rule level. Leave the box 
unchecked to ignore them.  

Specific table specification 

The basic spacing table supported will contain values in each cell to be used for all spacings between 
the net classes defined by its row and column. Usually there will only be values defined for one 
diagonal half of the grid to avoid duplicating the data, but a full grid of values can also be read. 

In order to import a variety of spacing table formats, a section has been included in this dialog to 
include check boxes for the user to choose any of the specialised table considerations we have been 
made aware of. 

Each net class contains two extra columns for pad spacings – Some spacing tables we have seen 
from a specific customer contain two extra columns after each net class containing special spacing 
values to match their manufacturing requirements, the maximum of which is used for the Pad to Pad 
and Pad to Copper spacing value. Check this box if this matches your spacing table. If checked, the 
import report will show this special pad spacing in brackets after the main class to class spacing 
value. 

Units 

Units for spacing values – select the units used in the CSV file from the drop-down list. You can 
specify different units to those in your design and used during import. If different in the CSV file, 
Pulsonix will convert the imported data into your design units during the import. Only spacing values 
that are numbers will be imported, blank fields and fields containing text will be ignored. 
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Using the dialog 
Select the options you require to match the CSV file and press OK to attempt to import the spacings, 
or press Report to show a report of what spacings it will add. 

The Import CSV Report 
The import Report button can be used before an import to inform you of what will be imported and a 
report will be created after import to tell you what has been imported. You can also run it a third time 
to verify the original file against the current Spacing contents, to see if anything has changed since 
you last imported the file. This way you can use this feature to import the net classes and original 
class to class spacing values when starting a schematic or PCB design, and then use the Report 
button towards the end of the design to show which class to class spacing sets now contain different 
values from the original spacings spreadsheet. 

Sample Report 
Import Class To Class Spacings 
------------------------------ 
Report Written : 21/10/2010 12:02:14 PM 
Design Path    : CSV Import Sample.pcb 
Design Title   : Import CSV Example Design 
Created        : 21/10/2010 11:49:35 AM 
Last Saved     : 21/10/2010 13:49:35 PM 
Editing Time   : 12 min 
Import File    : C:\temp\net spacing matrix.csv 
Units          : mm 
 
Import Summary 
-------------- 
Net classes found in import file row    : 12. 
Net classes found in import file column : 12. 
New net classes to be added : 9. 
 
Default net class spacings found in import file row    : 9. 
Default net class spacings found in import file column : 9. 
Existing net class spacings already with correct value : 0. 
Net class spacings that will have value changed        : 9. 
 
Class to class spacings in import file  : 63. 
New class to class spacings to be added : 63. 
Existing class to class spacings already with correct value   : 0. 
Existing class to class spacings that will have value changed : 0. 
 
The following net classes will be added: 
---------------------------------------- 
LCD safe 
LCD zener barrier 
pump 
segregated -11V supply 
segregated -7V supply 
segregated 3V switched 
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sounder 
unsafe power 
vibrator 
The following existing net class spacings will be changed: 
---------------------------------------------------------- 
"LCD safe" : 1.5 
"LCD zener barrier" : 1.5 
"pump" : 1.5 
"segregated -7V supply" : 2.0 
"segregated -11V supply" : 2.0 
"segregated 3V switched" : 2.0 
"sounder" : 1.5 
"unsafe power" : 1.5 
"vibrator" : 1.5 
 
The following new class to class spacings will be added: 
-------------------------------------------------------- 
"LCD safe" to "Ground" : 1.5 
"LCD zener barrier" to "Ground" : 1.5 
"LCD zener barrier" to "LCD safe" : 1.5 
"Power" to "LCD safe" : 1.5 
"Power" to "LCD zener barrier" : 1.5 
"pump" to "Ground" : 1.5 
"pump" to "LCD safe" : 1.5 
"pump" to "LCD zener barrier" : 1.5 
"pump" to "Power" : 1.5 
"segregated -7V supply" to "Ground" : 2.0 
"segregated -7V supply" to "LCD safe" : 2.0 
Etc. (full list of 63 line items truncated) 
Etc. (full list of 63 line items truncated) 
"vibrator" to "segregated -7V supply" : 2.0 
"vibrator" to "segregated -11V supply" : 2.0 
"vibrator" to "segregated 3V switched" : 2.0 
"vibrator" to "Signal" : 1.5 
"vibrator" to "sounder" : 1.5 
"vibrator" to "unsafe power" : 1.5 
 
                ---------------- End Of Report ---------------- 

 

 


